First Workshop for Product Evaluation

My First process
# Table of Contents

1. Workshop: Vacation Request........................................................................................................... 3  
   - Description of the Vacation Request Process ........................................................................ 3  
   - Scope ......................................................................................................................................... 3  
   - Modeling the Process step by step ......................................................................................... 4  
2. Defining and modeling the Process .............................................................................................. 4  
3. Process data ....................................................................................................................................... 16  
4. Forms creation ..................................................................................................................................... 26  
   - Activity: Register leave request ............................................................................................... 27  
   - Activity: Verify available vacation days .................................................................................... 33  
   - Activity: Approve leave request ............................................................................................... 33  
   - Activity: Register vacation leave .............................................................................................. 36  
   - Activity: Inform reject reason .................................................................................................... 39  
5. Business rules ..................................................................................................................................... 39  
   - Transition Conditions ................................................................................................................... 40  
   - Activity actions ............................................................................................................................. 43  
6. Performers ......................................................................................................................................... 49  
   - Activity: Register leave request ............................................................................................... 50  
   - Activity: Approve leave request ............................................................................................... 51  
   - Activity: Register vacation leave .............................................................................................. 53  
   - Activity: Inform reject reason .................................................................................................... 54  
7. Integrate with other applications ....................................................................................................... 55  
   - Install the Web Service locally .................................................................................................... 55  
   - Invoke Web service from Bizagi ................................................................................................. 58  
8. Work Portal ......................................................................................................................................... 64
Users.................................................................................................................................66
Parameters..........................................................................................................................70
Testing the Work Portal .......................................................................................................72
Optional mobile approval......................................................................................................76
Improving the work portal.....................................................................................................79
Sending a notification (optional)..........................................................................................84
9. Conclusion..........................................................................................................................90
   Next steps..........................................................................................................................90
10. Troubleshooting................................................................................................................90
1. **Workshop: Vacation Request**

A company has initiated a BPM strategy and has chosen Bizagi to support it. You have been selected to implement the Vacation Request Process.

The information about the Process and data to be controlled and visualized can be found in the following pages. Follow step by step the instructions of this manual and you will have automated the Vacation Request Process.

**Description of the Vacation Request Process**

The Vacation Request Process starts when an employee of the organization submits a vacation request.

Once the requirement is registered, the request is received by the immediate supervisor; the supervisor must approve or reject the request.

If the request is rejected the application is returned to the applicant/employee who can review the rejection reasons.

If the request is approved a notification is generated to the Human Resources representative, who must complete the respective administrative procedures.

**Scope**

This Process focuses on controlling vacation requests of the organization, from the initial request up to its approval or rejection.
Modeling the Process step by step

Bizagi has two main products:

- Bizagi Modeler: Used to diagram and document Processes
- Bizagi Suite: Used to turn the Process diagram into a running application (workflow).

We'll use Bizagi Modeler to diagram the Process and then we'll automate it using Bizagi Studio.

You can download Bizagi Modeler and Bizagi Studio here

2. Defining and modeling the Process

The Process modeling is the first step in the automation of a Process. Bizagi Process Modeler is a business process modeling and documentation tool. The modeler enables you to visually diagram, model and document business processes in industry-standard BPMN (Business Process Model and Notation). BPMN is a worldwide accepted format for process modeling.
Open Bizagi Process Modeler. A Pool consisting of one Lane will load upon startup. To name your Process, right-click on the Pool and select *Edit Text*. Type *Vacation Leave Request*.

Change the name of the main diagram; double-click on the Diagram name and type *Vacation Leave Request*. 
Include Lanes for the Process. Drag and drop a Lane from the Palette.

Rename the Lane; right-click the Lane and select *Edit Text*. Type *Employee*. 
Enter two more Lanes: Supervisor and Human Resources Administrator.

Drag and drop a Milestone from the Palette to add Phases.
Rename your Phase; double-click the Milestone to change its name and type **Register**.

Add a second Milestone and name it **Approval**.

We will start adding shapes to our Process. Select the Start Event from the Palette and drop it to the position of the Process diagram where it must be located.
The figures have a Pie Menu that allows the easy selection of shapes to be included in the diagram. It is displayed when positioning the mouse over a figure. The icons of the shapes that can be dragged and dropped are displayed when clicking on the figure.

Select the Task from the Pie Menu and place it besides the Start shape.

Rename the new task to *Register Leave Request*. You may rename the shapes and transitions by double-clicking on them.
**Important:** All transitions must be properly connected and all the figures must be inside Phases and Functional Areas.

Add the remaining shapes until the diagram looks like the following.

![Diagram](image)

Right-click on the *Verify available vacation days* Activity and transform it to a Service Task.

![Diagram with Service Task](image)

Save your BPM File. The file will be available for later documentation and changes.
Your Process flow is complete. Click on **Run Workflow**. This will take the diagram to Bizagi Suite which is the automation environment.

In the window that displays, select the Diagram to import and click **Next**.
In the next window you can rename your Process. The next window displays "Edit named before import", ignore and click **Next**.

Create a new Bizagi Project; select the **New** option and click **Next**.

Type a name for the Project: **BPMProject** and click **Next**.
There is a dialog here presenting Database information, ignore and press **Next**. Bizagi will then create the project for you, this might take a few minutes. Close the Bizagi Modeler.

The following configurations and instructions will be done in Bizagi Studio. Bizagi Studio will be opened when the wizard finishes exporting, so you will no longer need to work in Bizagi Process Modeler.

Once in Bizagi Studio, it is necessary to configure the duration, help text, and description of the flow and its contents. Right-click on the Process name and select **Properties**.

Enter the **Description** of the Process: This process controls the vacation requests of the employees of the company.

Scroll down to the bottom of the window and define the duration. Give an estimated time, a lower limit and an upper limit. These durations define the SLA of your Process.

When you are done, close the Properties window by clicking the Cross icon (“x”) on the right.
Right-click on **Register Leave Request** Activity and select **Properties**.

Enter a **Description** and a **Help Text**. The help text will be displayed to the end user when the Activity is executed in the Work Portal.

**Description**: This Activity allows the employee to enter the vacation request details.

**Help text**: Include all the information in your vacation request.

Click on **Duration** and enter the time as shown below. Then, close the Properties window of the Activity.
Once the properties of the Activity *Register leave request* have been entered, configure the following properties for each User Activity.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Help Text</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve leave request</td>
<td>Review the reasons for rejection request.</td>
<td>2 days</td>
</tr>
<tr>
<td>Inform reject reason</td>
<td>Post the event into the payroll system.</td>
<td>3 days</td>
</tr>
<tr>
<td>Register vacation leave</td>
<td></td>
<td>3 days</td>
</tr>
</tbody>
</table>

Once you are finished, **Save** your changes and close the Process Modeler Suite.

When you close the Process Modeler, you will return to Bizagi Studio and be taken to the Process Wizard. The Wizard guides you through all the necessary steps to automate your Process.
3. Process data

We will proceed to the creation of the data model. In Bizagi the data model includes all the information that the automated Process will need to display in the Work Portal and to request from end users.

The Vacation Leave Request Process includes the following information:

- Request date
- Employee
- Vacation start date
- Vacation end date
- Number of business days requested
- Number of available days
- Supervisor
- Flag (yes/no) for approved vacations
- Rejection reason
- Payroll code
- Administrative task date

All the information about the request such as dates, number of business days requested and available days will be grouped in the entity Vacation Request.
A standardized list about the possible rejection reasons will be designed in the entity Rejected Reason.

1. Go to the second step of the Process Wizard and select Model Data:

2. A window will display where you should enter the Process Entity. The Process Entity is the entity that gives you access to the rest of the data model, the starting point. Name it Vacation Request. Click Ok.

3. A new window to design the data model, containing the Process Entity will display. The creation of entities, attributes, and relationships can be completed in this editor.
4. Right-click on the Vacation Request entity and select Edit Attribute List.

5. The Attribute List Window for the Vacation Request entity is displayed; click on the **Add** button to create attributes; for each new attribute complete the following information:
   - **Display Name:** this is name that will be presented to the end user. It does not allow special characters.
   - **Name:** this field will be automatically filled by the system. This will be used for Business Rules.
   - **Type:** this is the data type of the attribute.
   - **Length:** applies for Strings, and determines how much end users can type in the fields.

Create the following attributes:

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Type</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request Date</td>
<td>Date - Time</td>
<td>None</td>
</tr>
</tbody>
</table>
### Attribute List for Vacation Request

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>Date - Time</td>
<td>None</td>
</tr>
<tr>
<td>End Date</td>
<td>Date - Time</td>
<td>None</td>
</tr>
<tr>
<td>Business days requested</td>
<td>Integer</td>
<td>None</td>
</tr>
<tr>
<td>Available days</td>
<td>Integer</td>
<td>None</td>
</tr>
<tr>
<td>Approved?</td>
<td>Boolean</td>
<td>None</td>
</tr>
<tr>
<td>Rejection comments</td>
<td>String</td>
<td>100</td>
</tr>
<tr>
<td>Payroll code</td>
<td>String</td>
<td>20</td>
</tr>
<tr>
<td>Administrative task date</td>
<td>Date - Time</td>
<td>None</td>
</tr>
</tbody>
</table>

6. The attribute list for Vacation Request will look as illustrated in the following screen.

![Attribute list for VacationRequest](image)

7. After you create the basic attributes, create those related to other entities.
Reject Reason entity is a Parameter entity that should be created, with its own attributes. Select the **New Entity** option. A new window will display to create a new entity and its attributes.

Our new entity will have the following information:

- **Display Name**: Enter the related attribute’s name that will be displayed in the form to the end user; this field does not allow special characters. We will use **Reject Reason**.
- **Type**: Enter the data type. **Entity – Parameter – New Entity**
The user must define if the entity’s values will be managed in the Production Environment by end users, via the Work Portal. If not, the entity’s information will remain hidden for end users. In this case Reject Reason will be manageable in the Production Environment because its values do not determine the Process flow. They are just shown for informative reasons.

Click **Next**.

8. The following window allows creating the attributes. This entity will have one, Reject reason, where the list of reasons to reject a request will be stored:

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Type</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reject Reason</td>
<td>String</td>
<td>100</td>
</tr>
</tbody>
</table>
Click Next.

9. Enter a Display Attribute for the entity. The Display Attribute is the visible attribute created for the entity that will be shown in the Work Portal when the entity is referred to. Select the one you just created.

Click Next.
10. A Summary window will display. Click **Finish** to return to the attribute list of the entity *Vacation Request*.

11. The entity *Vacation Request* is also related to a user entity. The user entity, known in Bizagi as *WFUser* is created by default for all projects, and is used to store all the information related to the end users. We need a relationship to this entity but since it is already created by default we just need to relate it. Press "Add" button and relate "Employee" to the SYSTEM entity as shown below (you need Entity option and then the System sub-option to find the WFUSER table)
12. For this example, the entity will be used to store all the information related to the employee requesting the leave. This entity can be found under System entities.

- Display Name: Type Employee.
- Type: Enter data type. Entity – System – WFUSER

13. Click Next. A Summary window will display for the Vacation Request entity.
14. Click **Finish**. The data model is complete, and it will be presented in a graphical way (you may need to re-position the entities on the screen by dragging and moving them):

15. Select the option **Add Related Entities** by right-clicking the **Vacation Request** Entity.
16. The complete diagram will display. Save and close the window.

4. **Forms creation**

Once the Process Diagram and the Data Model are ready we will proceed to create the forms associated with each one of the human activities of the Process. Forms are used to enter and display required information, so that end users may interact with the Process.
Bizagi helps modern businesses join the mobile work revolution and takes business processes automation to the next level.

You define a unique user interface through our powerful forms designer. Bizagi does the rest and optimally displays the information for each specific device.

**Activity: Register leave request**

The first Activity of the Process, *Register Leave Request*, must contain the following information:
We will now show you how to create this form. Go to the third step of the Process Wizard and select Define Forms.

1. You’ll see a diagram where only user Tasks are available to create Forms in. User Tasks that have no forms associated will be highlighted with an exclamation mark. Select the Activity Register leave request by clicking on it. The following screen will appear:
2. Click on the Controls tab to include a Group. Drag and drop a Group to the DROP HERE section.

3. Double-click on it and type *Request information*. Then click on the Check icon.
4. Go to the Layout tab to include a layout. Layouts help distribute the information and make it more appealing. Drag and drop one 50%-50% layout into the DROP HERE section within the Group.

5. Click on the Data tab to include the attributes in the layouts. Drag and drop the elements from the Data Model.

6. Request Date: Drag and drop the attribute in the first quadrant of the layout. This field must be read only. Click on the field and then click on the Gear icon that is displayed on its upper right corner. This gear will open the control’s Properties. Locate the Editable property and select the *not required* option (Cross icon). This will make the control read only.
7. Employee: Drag and drop the attribute in the second quadrant of the layout. This field must be read only. The *Editable* property and select the cross mark. This will make the control read only.

8. The Employee attribute is related to the *WFUSER* system entity. Therefore, it is necessary to relate a Display Attribute. Locate the *Display attribute* property, and select *fullName*. 
9. Go back to the Data tab. Drag and drop the following attributes from the Data Model as shown below. *Start date – End Date – Business days requested.*

10. These fields will be mandatory. Select them all holding down the CTRL key. Their Properties will be displayed. Select the Check mark on the *Required* property.
11. Save the form and close it to return to the Process Wizard.

**Activity: Verify available vacation days**

Since this is an automatic Task, no Form must be related. In step 6 of the Process Wizard (Define Integration Interfaces) we will see how the configuration is done for this Task.

**Activity: Approve leave request**

1. In the third step of the Process Wizard select the Activity *Approve leave request*.

   The Forms Designer will open.
   The first part of the Form will be exactly the same as the one designed before, so we will use the *Copy From* option to help us design faster.

   A new window displaying the Process flow will open. Select the *Register leave request* Activity by clicking on it. Click Ok.
2. The information is copied exactly as in the original form. To make the Controls *Start date*, *End date* and *Business days requested* read only we should set the Editable properties to False. Select them all at the same time clicking on them holding down the CRTL key and select *not editable* in the properties.

3. Add a new Group under the existing one. Go to the Controls tab, and drag and drop the Group underneath the existing one. Change its name to *Approval information*. 
4. The following controls will be entered, without a Layout.

- Available days: must have the Editable property set to False.
- Approved: the Required property should be set to True since this field is mandatory.
- Reject reason
- Rejection comments
- Employee’s Supervisor: Locate the Employee attribute in the data model. Expand it and drag and drop Employee - idBossUser – fullName attribute to the form. This control must be read only. Change the display name by double-clicking the Control and typing: Employee’s Supervisor.
5. Click the **Save** button once the Form has been completed and close it.

**Activity: Register vacation leave**

The creation of the form Register vacation leave will contain the information of the Supervisor’s Form as read-only and include the Controls that the Human Resources Assistant must complete.

1. Select the Activity *Register vacation leave* on the third step of the Process Wizard.

   We will add all the information we included on the *Register leave request* and *Approve leave request* Activities, as read only as we did in the previous step. Go to the *Copy from* option and select *Approve leave request* Task. Click **Ok**.
2. Change the *Editable* property to not editable for all Controls, in their Properties.

3. Include a Group on the bottom of the Form, by dragging and dropping a Group (found in the Controls tab). Change its name to *Register leave request*.

Then, include a 50%-50% Layout on the group, by going to the Layout tab and dragging and dropping the layout in the new group.
4. Go back to the Data tab. Drag and drop the attributes *Administrative task date* and *Payroll code* to each side of the new layout. Make them both mandatory (Required property).

5. Click on the **Save** button and close the Form.
Activity: Inform reject reason

Click on the Activity *Inform Reject Reason*, in the third step of the Process Wizard. Once again, use the *Copy from* option and copy the information from the *Approve leave request* Activity.

Set the *Editable* property to False for the fields.

Click on the *Save* button and close the Form. Select the green arrow at the top right of the Forms Designer to return to the Process Wizard view.

5. **Business rules**

The next step in the Process Wizard is the definition of business rules that control the Process routing.

The first rules to be completed are known as transition rules. These rules evaluate conditions and decide where the Process flow is to continue. They return True or False and they are associated to Gateway shapes.

We will create rules for the *Leave request approved?* Gateway: If the request was approved, the Process flow will continue to the *Register vacation leave* Task. If not, it will continue to the *Inform reject reason* Task.

Since there are two paths after the Gateway we will create a rule for one of the Transitions and make the other the default *Else* condition.
Transition Conditions

1. To create a Business Rule go to the fourth step of the Process Wizard and select *Define Expressions*:

2. The Rule editor will be opened highlighting the transitions that have no rule associated:

3. Select the transition named *Yes* that reaches the Activity *Register vacation leave* by clicking on the transition.
   Three options will be presented to take a route:
- Always: when selected Bizagi will always take that path ignoring the other sequence flows.
- Else: when selected Bizagi will take that path when no other path is valid. We recommend always having one sequence flow with this option.
- Based on the result of an expression: when selected Bizagi will evaluate an expression to take or not the selected path.

4. Select *Based on the result of an expression*. The list of system expression and previously created expressions will display. Since there are no expressions created, click **New**.

5. The Boolean Expression editor will display.
   Drag and drop the attribute *Approved* from the Data Model on the left to the condition item. Select the function *is Equal to* and choose the *true* option:
6. Click **OK**.

7. Select the transition from the gateway that reaches the **Inform Reject Reason** Task by clicking on it. Select **Else** from the options displayed, and then click **Ok**.

8. Go back to the Process Wizard by clicking the green arrow on the top right corner of the screen.

**Note:** in exclusive gateways Bizagi will give priority to the sequence flows with expressions over the ones with **Always** selected. That is, in a single exclusive gateway, if a sequence flow has **Always** defined and another sequence flow has an expression, Bizagi will take the expression path and disregard the Always path, when the expression is met.
Activity actions

We will create rules to automatically fill-in the fields Request date and Employee; this way, when a case is started these two Controls will be filled by Bizagi containing the information of today's date and the Employee logged in.

These rules will be created in the first Activity of the Process; we will include an Expression that sets the Date of the Request and to save the Case Creator as the Employee:

1. Go to the fourth step of the Process Wizard and select Activities Actions.

2. A new window will display the activities where you can add actions. Select the Register leave request Activity.

3. Select the On Enter option. Then click on the Plus icon to add an Action and select Expression.
4. The list of previously created expressions will display. Click **New**.

5. The Expression editor will display. Fill the **Display Name** and **Description** as follows; this information will let you identify the Expression for later use.
6. Right-click on the arrow and select *Add Expression*. Type *Applicant and Date* and click **Ok**.

7. Right-click on the module just included and select *Properties*. 


8. The Expression editor will display. Click on Data Model and select the **Employee** attribute. Click **Ok**.

9. The Employee attribute has been added to the Expression. Now enter an equal sign and then select the **Function** option. Navigate to the **Case creator user** Category, and select the **User Id of the case creator** function. Click **Ok**. Add a semicolon to demarcate the statement.
10. The first assignment is finished; the Employee user will be the case creator. We will now set the *Request date* to today. Position your cursor on the next line and open the data model. Select the *Data Model* option and then select the *Request date* attribute. Click *Ok*. 
11. The Request date attribute has been added to the Expression. Now enter an equal sign and then select the **Function** option. Navigate to the **Date & time** Category, and select the **Today** function. Click **Ok**.

12. Click the **Ok** buttons to save the assignments, save the rule and close the Activity Actions editor.
Press the green arrow at the top right to go back to the wizard.

6. **Performers**

The resources assignment is a very important stage within Bizagi. The responsible resources for each one of the Process activities are defined in this stage.

Bizagi identifies the relationship that exists between the different employees based on the variables that characterize and differentiate them. Thanks to this functionality, Bizagi allocates Activities intelligently to the different company members.

First we must define what would be an appropriate assignment for each one of the Process activities; later on, the configuration will be completed in Bizagi:

- The access to the Vacation Request Process is an internal process that must be available for all the employees of the organization. Thus, the first Activity must always be available for anyone who creates the case.
- The employee’s supervisor will ALWAYS complete the Activity Approve leave request.
- The user who submitted or created the request will ALWAYS complete the Activity Inform Reject Reason. (The reason for rejection is completed by the supervisor but ALLOCATED to the requester).
- The Inform Reject Reason Activity should ALWAYS be allocated to the person who submitted or created the case.
- The Human Resources Assistant will ALWAYS be responsible for the Register vacation leave Activity.

To configure the named allocations go to the fifth step of the Process Wizard.
The activities that do not have a Performer configured will be the ones highlighted in the workflow.

**Activity: Register leave request**

This Activity must be assigned to the creator of the case; this is a default functionality Bizagi provides, so we don’t have to create an assignment for it.
Activity: Approve leave request

1. Once in the diagram select the Activity by clicking on it, you’ll find the Performers assignment window.

2. Click **Add condition**.

3. In the new window we will select the Supervisor as the performer. Select **User Id** and then press Select Expression.

4. The list of system expressions will display.
5. Select the `CurrentAssigneeBoss` and click **Ok**. This instruction will automatically assign the creator’s Supervisor to the second task.
The Expression must look like this:

6. Click Ok to save the Performer Condition and Ok again to save the performer.

**Activity: Register vacation leave**

1. Repeat steps 1 and 2 for the Approve leave request Activity. This task is performed by an employee in the Human Resource department holding a position of Human Resource Assistant.
2. Since we have no Positions created we will create one:
In the first drop-down list, select Position. A new drop-down list is enabled at the right. Select Organization. This will enable the New link.

3. Type Human Resources Assistant and click Save.
Click Ok on all the windows to save the Assignment.

**Activity: Inform reject reason**

The Inform Reject Reason Activity should ALWAYS be allocated to the person who created the case.

1. Repeat steps from 1 to 4 from the Approve leave request Activity.

2. Select the Case Creator of the case and click Ok to save the condition.
3. Save the rule by clicking **Ok** for the Performers window.
   Close the Diagram by clicking the green arrow located on the top right corner of the screen to return to the Process Wizard.

7. **Integrate with other applications**

   Web Services will be used to integrate the Bizagi Process with the payroll system. It exposes a service that returns the number of available vacation days for a specific employee.

   There are two options to be able to implement this step.

   - The simplest one is if you have an internet connection. In this case you can use an existing web service available. No further configuration is needed and you can jump directly to the section Invoke the Web Service from Bizagi lower down.
   - If you don’t have access to an internet connection follow these steps to install the web services locally.

**Install the Web Service locally**

   Make sure you are connected to the internet. Download and unzip the file **VacationService.zip** that is found in: [http://download.bizagi.com/myfirstandsecondprocess/myfirstprocess/VacationService.zip](http://download.bizagi.com/myfirstandsecondprocess/myfirstprocess/VacationService.zip)
1. Copy the unzipped folder into your default web site local path, usually C:\inetpub\wwwroot.

2. Open the IIS Manager either by running the command `inetmgr` or by selecting it from the Administrative Tools in the Control Panel.
3. In the manager open the Default Web Site and find the VacationService folder. Right-click on it and select Properties.

4. In the VacationService Properties window click the Create button and then OK.
5. For Windows 7, right-click on the folder `VacationService` and select `Convert to Application`. Then click `Ok`.

**Invoke Web service from Bizagi**

1. From the Project Wizard go to the sixth step and select `Define Integration Interfaces`.
2. A view of the Process is presented. In this view, only the service Tasks will be active. Click on the task **Verify Available Vacation Days**.

3. The Interface Wizard opens up. Type the URL.
   - If the web service is installed locally, type: [http://localhost/VacationService/Vacations.asmx](http://localhost/VacationService/Vacations.asmx)
4. Click the Go button to see the available methods (this operation could take some time to finish). Select the method and click Next (the System and Interface Name takes default values that can be change if desired).
5. In this step the information from Bizagi to the web service will be configured. Two tables are shown, on the left is Bizagi’s data model and on the right the information the web service method expects.

Since the Employee’s (Applicant) username is used to obtain the available Vacation Days, in the Bizagi Data table, expand the VacationRequest element and go through the entities tree until you see the Employee’s username.

Once the desired attribute is reached, click on the userName attribute and then click on the id:String parameter on the right this will automatically connect the two items.
The tables may be moved and re-sized if needed; also the window can be maximized using the button on the upper right corner.

If the window is maximized, restore it to see the taskbar again and click on Next to continue.

6. In the next window select where, in Bizagi’s data model, the web service response is going to be saved. As in the previous step, two tables are shown but now the table with the web service response is on the left and the one with Bizagi Data on the right.
In Bizagi Data, under *VacationRequest* find the attribute *Availabledays* and match the response from the web service to this attribute. Then Click **Next**.

7. On the final step we will configure what to do if an error occurs, select the option *Throw Exception* from the *Action* list and click **Finish**.
8. The Interface wizard will close. Click on the green arrow on the right corner to return to the Process Wizard.

8. **Work Portal**

So far, the Process flow chart has been completed along with the structuring of the Process information, the Forms design for each one of the Process activities, the definition of the business rules and the performers. Now we are ready to configure the Work Portal.

Click on the seventh step of the Process Wizard. In the new window select *Run Process* and then *Development*.
You can also click the Green icon on the Ribbon for a quick access to the Portal.
Users

The work portal will have three users so that the behavior of the assignments can be verified. We will now create the three users directly from the web application. The following table presents the user list.

<table>
<thead>
<tr>
<th>User</th>
<th>Password</th>
<th>Domain</th>
<th>Immediate Supervisor</th>
<th>Job Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor</td>
<td>Supervisor</td>
<td>domain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Employee</td>
<td>Employee</td>
<td>domain</td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td>Assistant</td>
<td>Assistant</td>
<td>domain</td>
<td></td>
<td>Human Resources Assistant</td>
</tr>
</tbody>
</table>

Supervisor

1. To create the user select the Admin Menu and click the Users option.
2. Click on **New User**.

3. Fill out the information from the **user list table** presented at the start of this section.

BE CAREFULL to include a password you can remember or use the one in the given table. Bizagi will assign the User Name as password by default.

Deselect all checkboxes in the Basic Information tab: **Expired Password, Locked Account** and **Send Mail with Password to User**. Doing so will bypass authentication and **SMTP server validations**.
4. Click on Save to Save the Supervisor user.

**Employee (Applicant)**

1. Repeat [steps 1 to 3](#) from the Supervisor user creation.

2. To fill in the Supervisor field for the Employee user go to the *Configuration User* Tab and click the *Search icon* (🔍).

3. Click *Select* in the Supervisor record.
4. Click on Save to save the Employee user.

**Assistant**

1. Repeat [steps 1 to 3](#) from the Supervisor creation.

2. To Add the Position for the Assistant user go to the Organizations tab. Select the Organization from the list of Organizations by clicking “>.”

3. The Organization group will display. Select the position you want to add and click “>>” to add it. Save the user by clicking Save.
Parameters

Before executing the Process we must define rejection reasons.

1. Go to the Admin option in the Work Portal and select Entities; a new window will display a list of the Parameter Entities.

2. Select the Reject Reason entity, click on (+) to add a reason.
3. Enter the possible rejection reasons:

<table>
<thead>
<tr>
<th>Reject Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commitments make it impossible to take vacations on that date</td>
</tr>
<tr>
<td>No replacement available</td>
</tr>
<tr>
<td>Important event on the requested date</td>
</tr>
<tr>
<td>No Available days</td>
</tr>
<tr>
<td>Other reason</td>
</tr>
</tbody>
</table>

4. Click **Close**.
Testing the Work Portal

We will verify the Process after the information for the Parameter entities and users has been entered; Open the Command Prompt by typing the command `cmd`. Type `iisreset`.

**NOTE:** If because of any reason you are unable to execute the `iisreset` command, simply re-start your computer and run the process again.

Then, open the Work Portal, you’ll be asked to enter one of the credentials for the users created. Enter the application using the Employee User:
NOTE: If you have problems logging into the Work Portal check our Trouble shooting section, items 3 and 4.

1. Click on the **New** option and select the name of the Process: *Vacation Leave Request*.

2. Complete the information for the Activity; click on **Next** to continue with the Process. You will be informed that you have no pending activities for the Process. The assignee is now the Supervisor.

3. Log out from the application and Log in again with the **Supervisor** user.
The case will be displayed in the Supervisor’s Inbox as a pending task. Click **Work on it** to enter the case.

4. Fill in the information of the Activity; approve the request and click on **Next**.
Optional mobile approval

You can also download our [Bizagi mobile application](#) and login to see how the Supervisor can approve a request from a mobile device. Your mobile device and your project must share the same network. That is, be connected to the same wi-fi network.

Your browser has an address. This is the one you need to enter the application.

Log in with the user Supervisor and go to the Approve leave request task.
Notice how your information is displayed in a friendly way.

Keep in mind that since the request is approved, the next screen to be displayed by the system is the Activity *Register vacation leave* Task. Log out and log in again with the Assistant user.
The *Register vacation Leave* Activity is shown.

At any rate, if the request was not approved, then the *Inform Request Rejection* screen will be displayed to the Employee user.

5. When the case is finished the user will see a lock in the panel on the left, and a message informing there are no pending activities for the case.
Improving the work portal

Bizagi allows the modification of the controls’ appearance within the forms to achieve the look you desire.

Bizagi also offers a set of tools, that allow validating the information entered to ensure that the data entered by end users is adequate for each Activity and fulfills the different business conditions.

For this workshop we will show how to improve the user interface.

The *Rejected Reason* in the *Approve leave request* Activity should be displayed to the user only when the request is rejected; some Actions will be implemented in the Forms Designer to implement that functionality.

1. Go to the third step of the Process Wizard and open the form associated to the *Approve leave request* Activity.
2. Open the *Actions & Validations* option and click on the **Add** button on the window displayed.

3. Select the *When* condition. Click on **Add a condition**.

4. Scroll to the Control *Approved*. Then, choose the Operator *Is False*.
5. Go to the *Then* section. Click on *Add an Action*. Select the Command *Set required for*, the Control *Reject Reason* and the Argument *true*. This way when the Approved Control is false, the Reject Reason will be required. Repeat the procedure for the field *Rejection Comments*. 
6. Add two more Actions: Select the Command *Change visibility for*, the Control *Reject Reason* and the Argument *true*. This way when the Approved Control is false, the Reject Reason will be visible.
Repeat the procedure for the field *Rejection Comments*.

7. Scroll to the *Else* section. Click on **Perform the following actions** and click on **Add an Action**.

8. Select the Command *Change visibility for*, the Control *Reject Reason* and the Argument *false*. This way when the Approved Control is true or not filled, the Reject Reason will be hidden.
Repeat the procedure for the field *Rejection Comments*. 
Do the same for the *Set required for* command in order to avoid mandatory fields when they are no longer necessary. After pressing **OK** you need to close the window by pressing on the X.

![Create action dialog](image)

9. The new Action for RejectedReason and RejectionComments can be observed by going to the Approve Vacation Request Task in the Work Portal and selecting **Yes** or **No** for the Field Approved. Click **Ok**.

![Request information](image)
Sending a notification (optional)

The Process could be changed to send an automatic notification for the Inform Reject Reason Activity, in order to do this the Activity need to be converted into a service task. A SMTP Server would also be required, execute this step if you already have one.

1. Go to the first step of the Process Wizard and open the Process.

2. Right click on the Inform Reject Reason Activity and select Script Task under the Task type options:
3. Save the Process and close the Modeler. Go to the fourth step of the Process Wizard and select the option *Activity Actions*.

4. Click on the *Inform Reject Reason* Task and Add an *On Exit – Email*.

5. On the Message Window fill the *To* field as follow *VacationRequest-Employee-ContactEmail*

6. Include a subject as: *Your Vacation Request has been Rejected*

7. A text like this one must be included in the message:
Dear (Applicant full name):

We are sorry to inform your Vacation Request has been rejected. The reason for this rejection as follow:

(Reject Reason)

To include the applicant full name and Reject Reason, select the **XPath Field** option.

Navigate in the Data Model and select the attribute. Click **Ok**. The attribute will be included.

Your e-mail should look like this:
8. Click **Save** to close the e-mail Definition Window and then **Ok** on the Activity Actions Window.

9. Go to the **Configuration** tab in Bizagi Studio and select **Environment**.
10. The Bizagi Environment Options window will display. Fill in the information for the SMTP server as follow:
   - SMTP Server: Your SMTP Server Name
   - SMTP Server Account: A Valid E-mail Account on the domain. It will appear as return recipient of the emails sent.

11. Configure the Contact e-mails for the Employee. Go to the Work Portal, Admin-Users:
Make sure the e-mail is a valid e-mail address and click on **Save**.

12. Run the Application. Start a new case and reject the request, instead of looking to a form for the **Inform Reject Reason** Activity an e-mail will be sent and the case will be closed. The e-mail would have to look like this:

```plaintext
Dear Applicant

We are sorry to inform you that your Vacation Request has been rejected. The reason for this rejection is as follows:

No replacement
```
9. Conclusion

In this workshop you learned to diagram the flow of Processes, the design and creation of its data structure, the definition of business rules, and configuration of assignation rules for each one of the manual Activities and to connect with other applications via web. The final result was an easy-to-use Work Portal, which shows accurately the model created in Bizagi Studio; this result could be achieved because of the data driven concept of Bizagi.

Thank you for completing this workshop, for Bizagi it has been a pleasure to show you why we are the most agile solution to automate Process.

We hope that your experience with Bizagi has been satisfactory; should you have any questions or comments, please feel free to Contact us.

If you need to review the solution of the workshop, you may open Bizagi and the project will be available.

Next steps

1. To learn more about Bizagi BPM Suite please visit our Online Help.
3. Perform the Second Workshop for Product Evaluation to learn more advanced features.

10. Troubleshooting

This section deals with the most frequent questions arising from this workshop exercise:

1. I added the wrong shape. How do I delete it?
   Select the shape and press the delete key. A Lane can be deleted simply by right-clicking on the name and selecting the Delete option. Before deleting the lane there should be no shapes associated with it. To delete a Phase, select the Delete option that appears when you right-click on the top of the Phase. Remember that in order to be able to delete a Phase, there should be no associated shapes to the left of said phase.

2. I forgot to uncheck the checkboxes when I added the user.
When logging into the Work Portal, you will be asked to change your password. This may result in an authentication error. Please refer to question 4 in order to resolve the matter.

3. I can’t log in with the user I created. I get an authentication error.
For the purpose of this workshop, you need to bypass the authentication validation. In the Welcome page, select the Administrator Login at the bottom right. In the new window, leave the Password blank and click Login. The Work Portal will run with Bizagi’s default-created user: admon.
To edit the user, select Admin-Users and deselect all checkboxes in the Basic Information tab: Expired Password, Locked Account and Send Mail with Password to User. Check the Password field is filled. Doing so will bypass authentication and SMTP server validations.

4. I still can’t login, users are all blocked.
Open Bizagi Studio and click on the Modules icon located on the upper left corner. This will enable the Modules view, which is an advanced view. Go to Security module and locate Enable Quick Login as shown in the image below.

![Enable Quick Login](image)

Select ON (the tick mark should be off) and click Update.
When Quick Login is enabled you will not have to enter the user’s password in the Work Portal, just select the user you want to log in with. Click Run to test the Work Portal.
5. I checked the Notify by email option when creating a new user. I get an error when trying to send a new user notification email. You must configure your SMTP server to enable emails in order to avoid errors in the Work Portal. Follow the steps laid out in question four to login with the default-created user. To edit the information for the affected user, select Admin-Users and uncheck the email option.

6. I do not see the expected Activity when logging into the Work Portal. Ensure you have assigned the correct Performer to each one of the Process activities. Take care to login with the appropriate user.